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The BearingTrack program suite is designed for use with the Doppler 
Systems DDF6000 direction finder. BearingTrack collects information from 
a network of direction finders, displays the lines of bearing from the direction 
finder sites to a RF source, and predicts the location of the RF source. 
Direction finders are connected to the computer via a modem, a radio 
modem, or via the Internet or an intranet. 

In This Chapter 
Using this Manual ..............................................................3 
Overview of the Programs .................................................4 
Computer Requirements.....................................................5 
 
 

Using this Manual 
This manual is organized to get you up and running as quickly as possible.  
Following the introduction, chapter 2 will lead you through the installation 
process and guide you in configuring the programs.  Chapter 3 instructs you 
on using BearingTrack   Chapter 4 describes the creation of maps for 
BearingTrack using the MapFix utility program.  Chapter 5 briefly describes 
the networking of direction finders for BearingTrack.  Chapter 6 guides you 
in the use of BearingTrack Server, a utility program designed to interface a 
DDF 6000 to the Internet or an intranet.  Chapter 7 defines error messages 
and their potential source. 
 

C H A P T E R  1  

Introduction 
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Overview of the Programs 

BearingTrack 
BearingTrack collects information from a network of direction finders, 
displays the lines of bearing from the direction finder sites to a RF source, 
and predicts the location of the RF source. Direction finders are connected to 
the computer via a modem, a radio modem, the Internet, or an intranet.  You 
can use BearingTrack to change your direction finder settings and if you use 
a programmable ICOM receiver BearingTrack will automatically set the 
receiver to any desired frequency. 
 

LogViewer 
LogViewer reads log files written by BearingTrack and displays the latest 
information first.  LogViewer can be run from within BearingTrack or as a 
separate program. 
 

MapFix 
MapFix converts maps stored in bitmap format into a .map file that is used by 
BearingTrack to display the direction finder data.  Any graphic can be used 
as a map allowing maps to be hand drawn, scanned in, or captured from one 
of several commercially available map programs. 
 

BearingTrack Server 
BearingTrack Server connects a single direction finder to the Internet or an 
intranet.  A computer at the direction finder site is connected to the direction 
finder via the serial port.  The computer can be connected to the Internet via a 
dedicated line such as a digital subscriber line, or cable modem, a cellular 
digital packet data connection, or a dial up connection.  BearingTrack Server 
allows multiple TCP/IP connections so the computer at the site can run 
BearingTrack using a local IP address (typically 127.0.0.1) while any number 
of computers at remote locations can use BearingTrack to monitor and 
control the direction finder. 
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Computer Requirements 
BearingTrack requires a Pentium class processor based computer with at least 
32 Mbytes of RAM, a serial port and Windows 98, Windows NT 4.0, 
Windows 2000, Windows Me or Windows XP.    To use the warning sounds 
a Windows compatible sound card must be installed.  A monitor with at least 
800 x 600 resolution is needed.  BearingTrack Server requires a 486 class 
processor or better, 8 Mbytes of RAM, a serial port, Windows 95, Windows 
98, Windows NT 4.0, Windows 2000, Windows Me or Windows XP, and an 
Internet or intranet connection.  Installation requires a CD drive.  Contact the 
factory for floppy disks if needed.  
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In This Chapter 
Installing BearingTrack,  MapFix, and LogViewer ...........7 
Using the BearingTrack Program Suite .............................8 
 
 

Installing BearingTrack, MapFix, and LogViewer 
Place the installation CD into your CD drive.  An installation program should 
start.  If it does not start, press the start menu button in the lower left corner 
of the screen.  Select Run.  Type D:\setup in the text box and press Ok.  The 
installer will start and provide instructions to complete the installation. 

IMPORTANT NOTE: UPGRADING FROM A PREVIOUS VERSION OF 
BEARINGTRACK 

If you are upgrading from a previous version of BearingTrack, make a copy 
of the brgtrack.ini file prior to installing the new software.  Remove any old 
versions of BearingTrack using the Remove Programs application in 
Windows.  After you install the new version and prior to running it, copy 
brgtrack.ini into the installation folder (directory).  All your settings will then 
be transferred to the new version. 
 

C H A P T E R  2  

Getting Started 
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Using the BearingTrack Program Suite 
BearingTrack requires some setup in order to use it with your direction finder 
network.  First your network needs to be in place (Chapter 5).  Next you must 
create maps of the area or areas you want to cover with your network 
(Chapter 4).  Then you must enter data into BearingTrack describing the 
following 

 the name and location of your direction finder sites 
 how you are communicating with your sites 
 the CIV address of the direction finder and receiver at each site 
 the name and frequencies of the channels  you will use 

Once the data is entered BearingTrack is ready for use. 
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This chapter describes the setup and operation of BearingTrack.  
BearingTrack is designed to communicate with and collect data from a 
network (see "Designing Your Direction Finding Network" on page 41) of 
direction finders.  Each direction finder and receiver (if applicable) on the 
network must be set to a unique CIV address prior to running BearingTrack.  
See your DDF6000 manual for instructions on setting its CIV address. 

In This Chapter 
Setting Up BearingTrack....................................................10 
Running BearingTrack .......................................................22 
Playback .............................................................................32 
 
 

C H A P T E R  3  

Using BearingTrack 
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Setting Up BearingTrack 
Before you use BearingTrack you must enter data for each of the direction 
finder sites and if you are using a programmable ICOM receiver you will also 
enter the channels you will be using.  Launch BearingTrack by selecting it 
from the Start menu.  If you have maps saved in the MAP subdirectory of 
BearingTrack a screen similar to Figure 1 will appear.  If the map you wish to 
use is not displayed go to the Map menu and select it. 

 
 

Figure 1: Typical Startup Bearing Track Display 
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Entering Site Data 
In order for BearingTrack to display the sites it must know the location of the 
sites (latitude and longitude) and the address of the direction finder and the 
receiver at each site.  To enter the data, select Sites… from the Setup menu.  
The dialog in Figure 2 will appear.  Press the New button and enter the site 
name in the name dialog box.    

 

Figure 2: Site Dialog 
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A tabbed dialog, Figure 3, appears in the dialog box.  To enter the latitude 
and longitude of the site, either enter the coordinates directly or simply move 
the mouse onto the map.  When you move the mouse onto the map a small 
square will appear.  Move the square to the desired site location (the 
coordinates are displayed in the position box in the dialog) and then left click 
the mouse button to enter the position of the site.  Next select the type of 
receiver you are using.  If you do not intend to use BearingTrack to tune the 
receiver at the site different frequencies select None; otherwise select the 
type of receiver you are using.  BearingTrack works with ICOM receivers 
that use CIV serial communications and AOR receivers that use RS-232 
communications.  Now set the CIV address of the direction finder and if you 
selected ICOM set the CIV address of the receiver.  (Note: that if you are 
using an AOR receiver the direction finder automatically assigns a CIV 
address for the receiver that is the DF address plus 32.)  Use the combo boxes 
to set the color and the size of the squares representing the sites.  The width 
of the bearing line can also be selected.   If you are using Bearing Track with 
dial up modems click Enable Modem Connection and enter the site's phone 
number.  If you are using BearingTrack Server click Enable Internet 
Connection and enter the TCP/IP address and IP port number. 

Continue pressing the New button and entering the site data until all sites in 
your network are included.  To change the name of a site, simply double click 
on the tab and enter the new name.  The site editor can be used at any time to 
modify the site data 

 

                                     Figure 3: Site Data Entry Dialog 
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Entering Channel Data 
If you are using an ICOM programmable receiver you can use BearingTrack 
to remotely tune the receiver to any number of channels.  To accomplish this 
you must enter channel names and frequencies into BearingTrack.  Select 
Channels… from the Setup menu.  The dialog in Figure 4 will be displayed.  
In the frequency column enter the frequency of the channel.  In the Name 
column enter the name you would like to appear in the menu.  If you leave it 
blank the frequency will be used in the Channel menu.  If you want to disable 
the channel, click in the disabled column or use the arrow keys to move to the 
column and press the Enter key.  The Ant column automatically selects the 
proper antenna to use if a DDF6071 or DDF6076 antenna switch is installed.  

The import feature allows a user to import channel data from a comma 
separated variable (.csv) file.  The format of the file must be as follows 

fff.ffffff,nnnnnn<CR><LF> 

where fff.fffff is the channel frequency, nnnnnn is the channel name, and 
<CR><LF> are the carriage return and line feed characters respectively.  A 
simple way to make a .csv file is to use Microsoft Excel and save the file as 
.csv. 

To import the channels from a file press the Import button and a file open 
dialog will open.  Select the desired file and the frequencies will be imported.  
BearingTrack will give you an option to delete the current frequencies or add 
the imported channels to the current list. 

When you've entered all the channels you wish to use click OK. Now you can 
use the Channel menu to select the channel you wish to use.  Note the 
frequency of the receiver will not be set to the channel until the Run button is 
pressed. 

 

                                      Figure 4: Channel Dialog 
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Configuring the Direction Finder 
Once you've configured the sites, you can use BearingTrack to change the 
direction finder settings.  Select DF Settings… from the Setup menu.  A 
dialog similar to the direction finder front panel, Figure 5, will be displayed.  
Select the site you wish to configure using the site tabs.  The current settings 
of the direction finder will be displayed.  Use the mouse to push the buttons 
to make any desired changes to the settings.  All the settings are identical to 
the direction finder settings as explained in the DDF6000 manual except the 
Cal BRG to button.  The Cal BRG to button can be used to set the direction 
finder to a particular bearing.  A typical use for this function would be to tune 
the receiver to a beacon frequency.  Knowing the location of the beacon 
relative to the direction finder site the bearing can be calculated and entered 
into the text box next to the Cal BRG to button.  Next push the button and the 
direction finder is calibrated to that beacon location. 

 

Figure 5: Direction Finder Dialog 
 

Selecting the Serial Port 
If you are using the serial port to communicate with the direction finders you 
must tell BearingTrack which COM port you are using.  Select the COM port 
from the Serial Port menu under the Setup Menu. 
 

Options 
BearingTrack has a number of options that can be set by the user.  Factory 
defaults are set by clicking the Defaults button. 
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General 

Figure 6 shows the General parameter page.  The Serial poll time sets 
minimum time between polling events.  Polling is used when the direction 
finder sites are connected to BearingTrack using a serial device such as a 
telephone or radio modem.  Faster polling yields the most bearing data and 
uses the most network resources.  The minimum poll time is 500 ms.   

 

Figure 6: General Options Page 

The number of times to ignore no response to a DF poll sets the number of 
times the program will poll the sites without receiving a response before 
declaring the site down. 

The time to wait for a direction finder response sets the maximum time 
BearingTrack will wait after polling to receive a response before polling the 
next site and logging a no response received event. 

The time to wait for receiver response sets the maximum time BearingTrack 
will wait after sending a set frequency command. 

The ellipse uncertainty is set to the expected standard deviation of the 
direction finder errors.  This should always be set to 2 degrees unless the 
direction finders are in very poor locations which would increase their 
expected error.  This parameter determines the dimensions of the 95% ellipse 
(see "95% Confidence Ellipse" on page 48). 
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Alert Sounds 

Alert sounds are used to warn the user if communication with a site has 
failed.  If a site fails it is indicated in the bottom status bar by a down 
indication.  If the alert sounds are enabled, the program then produces a 
periodic sound alerting the operator that the site is not responding.  If two or 
more sites fail to respond, a different sound is produced to alert the operator 
of a more serious situation.  You can use the Alert Sounds tab to enable the 
alert sound and to set the frequency at which you would like to be alerted. 

 

Figure 7: Alert Sound Dialog 
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Administrator 

Access to the program options may be limited by the administrator.  Enabling 
the administrator option password protects access to the items selected in the 
dialog shown below.  Selecting any of the checked menus requires entry of 
the proper password, in order to have the menu selection accepted. 

 

Figure 8: Administrator Dialog 

To set the password, simply check the Enable Administrator Option.  The 
program will prompt you to enter the password.  To change the password 
simply uncheck the Enable Administrator Option box and then check it again. 
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Display 

During operation, BearingTrack collects and displays lines of bearing on the 
map.  At any time if a direction finder is operating normally but is not 
receiving a bearing, a Normal message will be displayed in the status bar at 
the bottom of the display in the color selected for the site.  If a new bearing is 
not received within a certain time frame, the bearing will first turn to gray 
and then disappear from the display.  The Display tab allows you to set the 
time to hold the bearing before dimming and also before disappearing. 

The Display tab also allows you to set the way the latitude and longitude are 
displayed. 

The virtual site color and width determines how virtual sites will be 
displayed on the screen. (See Virtual Site on page 31 for instructions on 
using virtual sites.) 

 

Figure 9: Display Dialog 
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Priority Channel 

During the operation of BearingTrack the operator can change channels at 
any time by selecting the channel name from the Channel menu.  If there is 
one particular channel that you want BearingTrack to monitor, you can set it 
as a priority channel.  If a priority channel is set and the operator selects a 
different channel, the program will go to the selected channel but it will 
return to the priority channel after a preset time.  Use the Priority Channel tab 
to select the priority channel and the time to remain on any channel other 
than the priory channel. 

 

Figure 9: Priority Channel Dialog 
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Network 

When the direction finder sites are connected to BearingTrack via the 
Internet or an intranet, the direction finders send data over the network as 
they obtain it.  However, direction finder setting and channel setting requires 
the direction finder and the receiver to respond to the commands sent to 
them.  The Network tab is used to set acceptable delay for the site to respond 
to a command.  If the site does not respond to the command an error dialog 
box will be displayed. 

 

Figure 10: Network Dialog 
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Playback 

The Playback File Options tab allows you to enable the recording of a 
playback file.  Once a playback file is recorded Playback can be selected 
from the File menu and the data recorded can be viewed. 

 
 

Check the Enable Playback File Recording to make BearingTrack write a 
Playback file whenever it is in the Run mode. 

Select New file daily at midnight if you want all the data collected for a 
certain day to be written into a file 

Select New file when Run button is pressed to start a new file each time the 
Run button is pressed. 
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Running BearingTrack 
Figure 11 shows the major areas of the BearingTrack Display.  At the top of 
the display is the main menu.  The main menu is used to  

- configure the program (as described previously), 

- to select the channel and map you wish to use 

 - to manipulate the display, 

- to log the incoming data, 

- and to print the displayed data 

 

Figure 11 : BearingTrack Display 
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The control buttons are used to control BearingTrack's mode of operation.   
The Off mode is used to set up the program and no data is displayed when in 
the Off mode.  In the Run mode, all incoming data is displayed on the screen.  
The program regularly samples the DF sites and displays the results.  The 
Hold mode is used to suspend the display of incoming data and holds the last 
data collected enabling the operator to print the screen. 

The Status display bar displays the currently selected channel, the currently 
selected map name, and the current time and date. 

At the far right of the status display bar there are two buttons.  The first 
button is used to turn logging on and off and display the status of the logging.  
If the button is down, Log Bearing Data is enabled.  The second button only 
appears if one or more of the sites requires a dial up connection to connect it 
to bearing track.  If the button is up, pressing it starts the connection process.  
If it is down, pressing it will hang up the modems. 

The center portion of the screen displays the map and graphically displays the 
location of the sites and lines of bearing from the sites to the RF source being 
tracked. 

At the very bottom of the screen, the bearing and S meter display shows the 
bearings measured at the direction finder locations and the signal strength of 
each received signal.  The bearing or status of each site is displayed in the 
same color text as the bearing site displayed on the screen. 
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Tracking an RF Source 
Once BearingTrack is configured, use the mouse to press Run.  Next select 
the channel you wish to monitor from the Channel menu.  Selecting the 
channel name sets the receivers at the DF locations to the selected channel 
frequency and begins monitoring the direction finders for bearing data.  The 
direction finder sites will be displayed as colored squares on the map (see 
Figure 12 below).  If a RF source is present at the channel frequency, lines of 
bearing will be displayed emanating from the site location.  Selecting the 
Estimated Position item in the View menu will display the estimated position 
of the RF source as a black square with the estimated latitude and longitude 
displayed below the site.  Selecting the 95% Confidence Ellipse item from the 
View menu will display an ellipse centered on the estimated position.  Given 
the bearing measurements, there is a 95% chance that the RF source is 
somewhere within this ellipse.   

When BearingTrack is receiving a bearing from a site the measured bearing 
and the receiver S meter reading will be displayed in the Bearing and S-meter 
display bar near the bottom of the display.  After a source stops transmitting, 
the bearing will be held for the time set in the Display Options  dialog.  When 
the bearing is being held, it will be displayed in italics.  If for some reason the 
site does not respond to a poll, the bearing will be crossed out.  During times 
when no bearing is displayed and communications with the site are normal, 
the word Normal will be displayed.  If there is no bearing to display and the 
site does not respond to polling commands from BearingTrack the word 
Down will be displayed. 
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Figure 12: Typical Bearing Track Display 
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Adjusting the Display 
The View menu is used to adjust the display.  Select Bearing Lines to display 
lines of bearing at each site using the measured bearing data.  Selecting 
Estimated Position causes Bearing Track to calculate the estimated position of 
the RF source from the collected bearing data and the known site locations.  
The estimated position is displayed as a small black square near where the 
lines of bearing intersect.  Below the square the latitude and longitude of the 
estimated position is displayed.  Note that if only two sites are used, the 
estimated position will always be at the intersection of the two lines of 
bearing.  Selecting 95% Confidence Ellipse causes BearingTrack to draw an 
ellipse centered on the estimated position.  Given the Direction Finder rms 
error (typically 2 degrees) and the measured bearings there is a 95% chance 
that the RF source is within this ellipse. 

If some part of the map is not visible on the screen you can use the scroll bars 
for panning. You can also zoom in or out with commands in the View menu 
or by pressing the right mouse button and selecting Zoom In or Zoom Out.  
 

Changing Maps and Channels 
While running BearingTrack the map you are using and the channel can be 
changed at anytime.  Simply select the desired map or channel from their 
respective menus.  In order for the available channels to be in the menu they 
must be enabled.  When in the Run mode the channel frequency will be 
changed immediately to the selected channel frequency.  In any other mode 
the frequency will not be changed until the Run button is pressed. 
 

Logging the Data 
To log the incoming data select Log Bearing Data from the File menu or press 
the Logging button.  A file named yyyyddmm.log will be created in the log 
directory where yyyyddmm is the year, month, and day the file was created.  
As long as Log Bearing Data is checked the time, date, site name, measured 
bearing, S meter reading, and the selected channel are written into the file.  If 
Log Bearing Data is enabled and the program is running at midnight, Bearing 
Track will close the file it is using and create a new file for the current day.  
An example of a log file is shown below   

Time Date Site Channel Frequency Brg S 

10:07:56 AM 12/3/00 Site 1 Channel 0 146.1111 256 9 

10:07:56 AM 12/3/00 Site 2 Channel 0 146.1111 153 9 

10:07:56 AM 12/3/00 Site 3 Channel 0 146.1111 32 9 

10:07:56 AM 12/3/00 Site 1 Channel 0 146.1111 256 9 
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10:07:56 AM 12/3/00 Site 2 Channel 0 146.1111 153 9 

10:07:56 AM 12/3/00 Site 3 Channel 0 146.1111 32 9 

10:07:57 AM 12/3/00 Site 1 Channel 0 146.1111 257 9 

10:07:57 AM 12/3/00 Site 2 Channel 0 146.1111 154 9 

10:07:57 AM 12/3/00 Site 3 Channel 0 146.1111 33 9 

10:07:57 AM 12/3/00 Site 1 Channel 0 146.1111 258 9 

 

The contents of the file can be displayed by any program capable of reading a 
text file (e.g. WordPad or Microsoft Word.) or by the LogViewer utility 
application provided with BearingTrack. 
 

Logging Events 
Event logging can be useful to determine if sites are responding as expected.  
Simply select Log Events from the File menu and BearingTrack will record 
each the program transitions state.  It will also record any times a site is 
polled via the serial port but no response was received.  This data can be used 
to set the program delays and sampling times to achieve optimal operation.  It 
also can be used to spot a site the repeal fails to respond to messages sent to 
it. 
 

Printing 
When you have frozen the sampling, using the Hold button, you can send the 
screen image to your printer.  Simply select the Print command from the File 
menu. The time and date, the channel name, and the map name also appear 
on the printout.  When in the Run mode you can obtain a screen shot by 
simply pressing the F1 key. 
 

Setting the Sampling Delay 
If you are using BearingTrack with a direction finder network consisting of a 
combination of radio modems and direct serial connections, it may be 
necessary to set the Sampling Delay.  To determine if you need to set the 
Sampling Delay, use the Setup menu to set the sampling delay to Auto and 
then press the Run button.  If you get an error stating that the Direction finder 
at a site with a radio modem is not responding, increase the sampling delay 
by selecting Sampling Delay from the Setup menu and press Run again.  
Continue to increase the sampling delay until you achieve reliable operation.  
It is important to use the minimum sampling delay possible to achieve 
optimum operation of the direction finder network. 
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Scanning Channels 
BearingTrack can be programmed to scan the channels that are entered into 
it.  To enable scanning, select Scan Channels... from the Settings menu.  The 
following dialog box (Figure 13) will be displayed 

 

            Figure 13: Channel Scanning Dialog 

Check the Time to dwell on a channel check box and enter the time you would 
like BearingTrack to listen to a channel before changing to the next channel.  
This will enable channel scanning.  If after receiving a bearing you would 
like to stay on that frequency for a fixed time and then move on, check Time 
to stay on a channel after receipt of a bearing and enter the time you want 
BearingTrack to stay on a channel after it receives a bearing. See the timing 
diagram below. 
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If you want to stay on a channel until the signal is gone click on Time to stay 
on channel after no bearing is received and enter the time you want to dwell 
on the channel after the signal is gone.  See timing diagram below. 

 
 

Calibrating to a Beacon 
BearingTrack can be calibrated by using RF sites at known locations on 
known frequencies (beacons) such as weather channels.  To perform the 
calibration put BearingTrack in the Run mode and select the beacon channel 
from the channel menu.  Make sure that the sites you wish to calibrate are 
indicating a bearing reading.  Next place the mouse pointer on the site you 
wish to calibrate and click the right mouse key.  Select Calibrate... from the 
pop up menu and a dialog box will be displayed.  Enter the bearing between 
the site and the beacon and then press the Calibrate button.  Shortly after you 
press the Calibrate button, a new bearing will be displayed that points toward 
the beacon. 
 



 

30 BearingTrack User's Guide 
 

Using Dial Up Modems 
BearingTrack can be used with dial up modems.  A typical network of 
Direction Finders using modems is shown in the Designing Your Direction 
Finder Network section.  During Site Setup the phone number of each site 
that uses a modem is entered.  To connect cause the modems to dial the sites, 
first turn off all modems and then press the modem connect button at the far 
right of the status display bar at the top of the screen.  The program will 
respond by providing you directions on what to do to complete the 
connection process.  Once all the modems are connected you can then use 
BearingTrack to gather bearing data from the Direction Finder sites and to 
change the direction finder sites. 

To disconnect, simply press the button again and the modems will terminate 
the phone line connection. 
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Tuning the Receiver 
In BearingTrack select Tune Receiver from the Options menu or type ctrl-T on 
the keyboard.  The dialog shown below will appear.  To tune the receiver 
enter the desired frequency in the edit box, use the mouse to turn the dial, or 
use the up-arrow and down-arrow keys.   

              

 

Virtual Site 
A virtual site is a site you temporarily add to the screen to display a bearing 
that is taken at another mobile or fixed site.  For instance if a mobile operator 
is using a DDF6002 he could radio in his position and a bearing reading to 
the BearingTrack operator.  The BearingTrack operator can then enter a 
virtual site to aid in the location of the RF source.  

To add a virtual site, right click the mouse on the map display where you 
want the virtual site to be located.  Select Add Virtual Site from the popup 
menu.  A virtual site will be displayed along with an edit box for the bearing.  
Using the keyboard enter the bearing and hit the Enter key.  The virtual site 
will now display the location of the site and a bearing line. 

To change the bearing of a virtual site, place the mouse over the site and right 
click it.  Select Set Bearing from the pop up menu and enter the new bearing. 

To delete a virtual site, left click on the site and press the Delete key. 
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Playback 
Playback enables you to playback files you have previously recorded and 
display them on a map.  Playback files are written by BearingTrack when 
Playback is enabled in the options menu. 
 

Opening a Playback File 
To Open a file to playback, select Playback... from the File menu.  A standard 
windows dialog to open a file will appear.  The file extension for a playback 
file is .bpb.  The files are named by using the date and time they were created 
as follows 

yyyymmddhhmmssxxx 

where 

yyyy is the year the file was created 

mm is the month the file was created 

dd is the day the file was created 

hh is the hour the file was created 

ss is the second the file was created 

xxx is the millisecond the file was created 

Select the desired file and press open. 
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Controlling Playback 
Once you've opened a playback file, the playback window will appear on top 
of the map display.  Using this control you can set the playback starting 
position, playback the file in real time, playback the file in fast forward, 
reverse the playback, and advance or go back a single record.  A record 
consists of  

 the bearing 
 the date and time the bearing was recorded 
 the site where the bearing was recorded  
 the channel the receiver was set to when the bearing was recorded 
 the S meter reading of the direction finder when the bearing was recorded 

The Playback dialog is shown below. 

 

Use the slider control to position select a certain record in the file.  The 
bearing display on the map and the time will change as you move the slider 
to help you find the record you want. 

Press the forward button to start playback.  Playback will proceed in real time 
with the actual time the bearing was recorded appearing in the time display. 

Use the fast forward button to speed up the playback by a factor of 10. 

Use the reverse button to move backwards through the file. 

Use the stop button to stop and hold the currently displayed bearing and time 

Use the advance one record button to get the next record in the file and 
display it. 

Use the go back one record button to get the previous record in the file and 
display it. 

You can stop Playback at any time by simply clicking on the close box in the 
upper right hand corner of the Playback dialog box. 
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To create a Bearing Track map use the MapFix program. MapFix is installed 
on your hard disk in the same directory as Bearing Track. An icon for 
MapFix is placed in your Bearing Track program group.  With MapFix you 
can import an image and assign latitude and longitude coordinates to it.  Then 
save the file and you are ready to use the map in Bearing Track. 

Technically, a Bearing Track map is a pixel-based image (a bitmap) that is 
stored in a file together with coordinate information. To make a map, you 
must first create a map image and store it in a graphics file.  You can create a 
map image by using a commercially available map program or by using a 
scanner.  When you have such a file, you import it to Map Fix. The next step 
is to assign coordinates to the image. When you have assigned coordinates, 
you can check the coordinates of any location by moving the mouse. The 
latitude and longitude of the cursor location are displayed at the top of the 
screen. Finally, you save the image with coordinates as a map file. 

There are some things you should consider when making a Bearing Track 
map. If the map has many details and/or is very dark, you might find it hard 
to see bearings on the screen. It is advisable to use a map with fairly pale 
colors or with limited detail.  

In This Chapter 
Creating a Map Image........................................................36 
Using a map program.........................................................36 
Using the MapExpert program...........................................36 
Scanning in an Image .........................................................37 
Graphics File Formats ........................................................37 
Importing the Image...........................................................37 
Assigning Coordinates to the Image ..................................37 
Checking Coordinates ........................................................39 
Saving the Map File ...........................................................40 
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Creating a Map Image 
To make a map you first need a graphics file containing a map image. You 
cannot use MapFix to create this file. A convenient way of making a graphics 
file is to use a map program. Alternatively, you could scan in an image from 
a hard copy map or obtain one from a web site such as MapBlast.com. Since 
graphics files consume space on your hard disk, you might want to delete 
them after you have used them to make Bearing Track maps. 
 

Using a map program 
If you have a map program with maps of the region you are interested in, the 
map program will let you save a portion of a map to a graphics file, which 
you can import to Map Fix. Only the image itself (without any coordinate 
information) will be saved to the graphics file. Thus, you must use the map 
program to determine the latitude and longitude of two locations on the map. 
You need this information to assign coordinates to the map. There are several 
map programs available on the market, for instance MapExpert .  
 

Using the MapExpert program 
For your convenience, a brief description of how you can create a graphics 
file with the MapExpert 2.0 program follows (MapExpert is produced by 
DeLorme Mapping). 

After starting the MapExpert program, the first step is to locate the map you 
want. You can do this for instance by giving a place name in the Locate Place 
Name dialog box (Geography menu). Next, you can adjust the scale and 
amount of detail by zooming in or out (Display menu). Pan the map (click 
with the map cursor to where you want the center of the map to be) until you 
are satisfied with what you see on the screen. You now need to determine the 
latitude and longitude of two locations, for later use with Map Fix. These 
locations should be relatively far apart, preferably along a diagonal of the 
image. Position the map cursor over a location and read off (and write down) 
the coordinates at the bottom of the screen. 

You might want to repeat the procedure and make several graphics files. For 
instance, you could make one overall map of your region, and then construct 
four maps at higher magnification for the SW, NW, NE, and SE parts of your 
region. 
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Scanning in an Image 
If you create a map image by scanning it in from an image on paper, make 
sure that you orient the paper image with north in the upward direction, so 
that latitudes become horizontal and longitudes vertical. You then use your 
scanning software to save the image as a graphics file. 
 

Graphics File Formats 
There are a great number of file formats for storing images. Almost all of 
these are pixel based. A given format can usually store several kinds of 
images (different numbers of colors per pixel and different compression 
schemes). It is also possible to store an image as graphics drawing commands 
(the Windows Metafile Format is of this type), but Map Fix only handles 
bitmap (.bmp) images.  Common programs such as Microsoft Paint or 
Microsoft Imager can easily convert any standard graphics file into a bitmap 
image. 
 

Importing the Image 
To import a graphics file containing a map image to Map Fix, select the 
Import option from the File menu or click the Import button on the tool bar. A 
file open dialog appears. By default, the dialog box is set for import of BMP 
files.. Then go to the directory where the graphics file is located, select the 
file and click OK. The map image then appears on the screen 
 

Assigning Coordinates to the Image 
Map Fix and Bearing Track use latitude and longitude to determine positions 
on a map. The map must be oriented so that north is in the upward direction, 
making latitudes horizontal and longitudes vertical. 
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Latitude and longitude 
Using the option Display Seconds or Display Minutes in the Display menu you 
can control the format in which latitudes and longitudes are displayed. 
Latitude is measured as degrees north or south of the equator. A degree is 
divided into 60 minutes, and a minute into 60 seconds. As an example, the 
latitude north 35 degrees, 22 minutes, and 30 seconds is written as N 35° 22' 
30.0". Alternatively, the same latitude can be given without seconds as N 35° 
22.500'. Longitude is measured as degrees east or west of the Greenwich 
meridian. As an example, the longitude west 108 degrees, 12 minutes, and 15 
seconds is written as W 108° 12' 15.0". Alternatively, the same longitude can 
be given without seconds as W 108° 12.250'. 
 

The Enter Points menu 
Using commands in the Enter Points menu or on the tool bar, you assign 
coordinates to your pixel image by specifying the latitude and longitude of 
two locations on the image. Thus, you need to know the latitude and 
longitude of two points that you can identify and select with the mouse. You 
are free to choose any two points, except that they must define a rectangle 
(they cannot line up). To achieve maximum precision, you should see to it 
that the two points are fairly far apart, preferably along a diagonal of the 
image. The following commands appear in the Enter Points menu:  

Fix Point 1: Determine the location and latitude and longitude of the first 
point. When you select this option, the cursor changes to a cross. Move 
the cross to the right location and click the mouse. Enter the latitude and 
longitude of the location in the dialog box that pops up. The location you 
have chosen is marked in red on the screen. If you are not satisfied, select 
Clear Points from the Enter Points menu and repeat the process. 

Fix Point 2: Determine the location and latitude and longitude of the second 
point. When you select this option, the cursor changes to a cross. Move 
the cross to the right location and click the mouse. Enter the latitude and 
longitude of the location in the dialog box that pops up. The location you 
have chosen is marked in blue on the screen. If you are not satisfied, 
select Clear Points from the Enter Points menu and repeat the process. 

Clear points: Use this option if you want to start over fixing points. 

 
 

The Display menu 
Seconds: Display and enter latitude and longitude as degrees, minutes, and 

seconds, where seconds are given with one decimal. This option is on by 
default. 
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Minutes Display and enter latitude and longitude as degrees and minutes only, 
where minutes are given with three decimals. 

In the figure below, the coordinates for the second point has been entered into 
the dialog. The first point is shown as a cross in the lower left part of the 
screen.  

 

 

Figure 14 : Fixing the Coordinates 

 
 

Checking Coordinates 
When you have assigned coordinates to the image, you can check the 
coordinates of any location by moving the mouse. The latitude and longitude 
of the cursor location are displayed at the top of the screen in the tool bar.  
 



 

40 BearingTrack User's Guide 
 

Saving the Map File 
Use the Save map option in the File menu to open a dialog where you can 
save the map image with coordinates to file. The file name extension for a 
BearingTrack or AutoTrack map file is .MAP.  Type in the map name you 
wish to use in BearingTrack or AutoTrack.  If you save the map to the Map 
subdirectory, BearingTrack will automatically load these maps when the 
program is first started.  However, you may save the maps anywhere on your 
hard disk.  Saving a map is available only after you have imported a graphics 
file and fixed the latitude and longitude of two points on the map 
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There are a number of ways of connecting a number of direction finders to 
the computer running BearingTrack.  This chapter discusses three of the most 
common techniques: radio modem, telephone line, and the Internet.  It is 
important to note that these three connection types can be combined; so, for 
instance, if you had three direction finder sites one DF could be connected 
via a radio modem, one via a telephone line, and one via the Internet.  Note: 
When combining direct serial connections with radio modem connections it 
may be necessary to set the sampling delay to something other than Auto. The 
discussion below is general in nature; for more specific instructions on 
networking DDF6000 direction finders with specific radio modems and 
telephone modems see the application notes on our web site 
http://www.dopysy.com". 

In This Chapter 
Radio Modems ...................................................................42 
Telephone Modems............................................................43 
Internet or Intranet..............................................................44 
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Radio Modems 
Radio modems may be used to connect a PC located at a control site to 
remotely located direction finders and receivers. A radio modem is required 
at each remote site and at the control site. All radio modems must be set to 
the same frequency for both transmission and reception. The "host" radio 
modem is located at the control site and connects to the PC running 
BearingTrack. This modem transmits and receives data from each of the 
remote site radio modems.  Multiple sites may be connected as shown in 
Figure 15. There is no limit to the number of sites that may be connected. 
However, the response time will be reduced as the number of sites increases 
since it takes about 200 milliseconds to poll each site using radio modems. 

                   

 

   Figure 15 : Radio Modem Configuration 
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Telephone Modems 
The BearingTrack software, allows one or more of DDF6000 direction 
finders to be controlled remotely over leased telephone lines. A modem pair 
is required for each remote site. The "calling" modem is located at the central 
control point where the PC running BearingTrack is located, and the 
"answering" modem is located at the remote site. Figure 16 shows how 
multiple sites are to be connected. The Serial Expander, DDF6077 is 
available from Doppler System. A Serial Expander will interface a single PC 
COM port with up to three calling modems. If more than three sites are to be 
connected, multiple Serial Expanders may be used. There is no limit to the 
number of sites that may be connected. However, the response time will be 
reduced as the number of sites increases since it takes about 135 milliseconds 
to poll each site using telephone modems. 

 
 

Figure 16: Telephone Modem Configuration 
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Internet or Intranet 
BearingTrack can control and extract data from a network of DDF6000 
direction finders that are connected to the Internet (see Figure 17).  A 
minimally configured PC is required at each direction finder site.  The 
computers at the remote sites all run BearingTrack Server to interface the 
direction finders to the Internet.  The Internet connections at the host site and 
the direction finder sites can be dedicated connections such as DSL or cable 
modem, dial up connections, or cellular digital packet data connections.  The 
only requirement is that the IP address of the remote connections be known.  
The setup and operation of BearingTrack Server is discussed in Chapter 6. 

 

Figure 17: Internet Configuration 
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BearingTrack Server is a program that interfaces a DDF6000C to the 
Internet.  To use it you must first have an Internet connection with a 
dedicated IP address for each remote site you are going to connect to the 
Internet.  The Internet connection could be via a dial up connection, a digital 
subscriber line, a cable modem, or a cellular digital packet data connection.  
The IP address is of the form xxx.xxx.xxx.xxx where xxx is an integer 
number between 0 and 255.  Contact your Internet service provider about 
obtaining a dedicated IP address. 

When you first start BearingTrack Server, the display shown in Figure 18 
will appear on the screen.  Set the Serial Port to the port the direction finder 
is connected to.  Set the DF address to the address you programmed into the 
DF and set the RX address to the receiver address.  If you are using an AOR 
receiver set the receiver address to AOR 5000.  Next set the Internet port that 
BearingTrack Sever will listen to.  Finally set Maximum Connections to the 
number of connections you will allow at this site.  If your direction finders 
are on the Internet several computers each running BearingTrack can connect 
to the direction finder sites.  This feature allows you to access your direction 
finder network simultaneously from several computers.  Set the maximum 
connections to 1 if you want to disable simultaneous connections.  Next click 
run and BearingTrack Server is monitoring the Internet for the BearingTrack 
application to connect to it. 

 

Figure 18: Bearing Track Server Display 

C H A P T E R  6  

Using BearingTrack Server 
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If your system loses power and the computer at the remote site reboots you 
will want BearingTrack Server to restart.  To properly restart, create a 
BearingTrack Server shortcut and place it in your startup folder.  The 
configuration settings are automatically saved and will be used when the 
program restarts. 
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This section defines terms commonly used throughout this manual. 
 

Direction Finder Site 
A direction finder site is a location where a DDF6000 direction finder, a 
receiver, an antenna, and some type of data relay device resides  
 

Channel 
A channel is the name and frequency to which the receiver is tuned. 
 

Lines of Bearing 
Lines of bearing, are lines emanating from the direction finder site _ 
 

Estimated Position 
The estimated position is the most likely position of the radio frequency 
source.  BearingTrack collects bearing  information from a network of 
direction finders and using this information it estimates the position of the 
radio frequency source. 
 

C H A P T E R  7  
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95% Confidence Ellipse 
The 95% Confidence Ellipse displays the area in which BearingTrack 
calculates that there is a 95% chance that the RF source resides.  This ellipse 
is calculated based on the assumption that each direction finder as an error 
standard deviation of 2 degrees.  Antenna mounting and location can affect 
direction finder errors.  Contact the factory for antenna mounting advice. 
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Some common error messages you might encounter are listed below 

 

Error in opening communications port 
The COM port is either being used by another program or device.  Try using 
another COM port or restarting your computer. 

No sites have been defined 
You cannot perform any direction finder settings unless sites have been 
defined. 

The direction finder at does not 
support UHF2 Antenna Selection 

This error occurs if you selected the UHF2 antenna in the Channel frequency 
dialog and you are using a DDF6000B that does not support three antennas. 

The direction finder at site xx does 
not support antenna selection 

This error occurs if you selected the UHF2 or UHF1 antenna in the Channel 
frequency dialog and you are using a DDF6000A or earlier direction finder. 

C H A P T E R  8  

Error Messages 
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The receiver at site xx did not 
respond to the last xxx command 

ICOM receivers respond with an OK message when they properly receive 
and execute a command.  The frequency may not be set.  Try again, but if 
you continue to get this error there is a problem with your serial or IP data 
connection.  Check your cables and modems.  If this does not fix the problem 
there may be something wrong at the remote site.  If using an intranet or the 
Internet try switching to the off mode and then back to run to reestablish the 
connection.  

The direction finder at site xx did not 
respond to the xxx command 

The DDF6000 direction finders respond with an OK message when they 
properly receive and execute a command.  If you receive this error, the 
direction finder may not have received the last command. Try again, but if 
you continue to get this error there is a problem with your serial or IP data 
connection.  Check your cables and modems.  If this does not fix the problem 
there may be something wrong at the remote site.  If using an intranet or the 
Internet try switching to the off mode and then back to run to reestablish the 
connection.  

The network connection at site xx has failed 
A TCP/IP error has occurred in the network connection.  The exact cause of 
the error is displayed in the dialog box.  If you are unable to reconnect, 
chances are that the server is experiencing a problem. 

Log File cannot be opened 
The log file may be in use by another application. 



 

 51 
 

9 
95% Confidence Ellipse • 16, 48 

A 
Adjusting the Display • 27 
Administrator • 18 
Alert Sounds • 17 
Assigning Coordinates to the Image • 37 

B 
BearingTrack • 4 
BearingTrack Server • 4 

C 
Calibrating to a Beacon • 30 
Changing Maps and Channels • 27 
Channel • 47 
Checking Coordinates • 39 
Computer Requirements • 5 
Configuring the Direction Finder • 15 
Controlling Playback • 34 
Creating a Map Image • 36 
Creating Maps for Bearing Track • 35 

D 
Definitions • 47 
Designing Your Direction Finding Network • 3, 

8, 9, 41 
Direction Finder Site • 8, 47 
Display • 19, 25 

E 
Entering Channel Data • 13 
Entering Site Data • 11 
Error Messages • 47, 49 
Estimated Position • 47 

G 
General • 16 
Getting Started • 3, 7 
Graphics File Formats • 37 

I 
Importing the Image • 37 
Installing BearingTrack,  MapFix, and 

LogViewer • 7 
Internet or Intranet • 44 
Introduction • 3 

L 
Latitude and longitude • 38 
Lines of Bearing • 47 
Logging Events • 28 
Logging the Data • 27 
LogViewer • 4 

M 
MapFix • 4 

N 
Network • 21 

O 
Opening a Playback File • 33 
Options • 15 
Overview of the Programs • 4 

P 
Playback • 22, 33 
Printing • 28 
Priority Channel • 20 

R 
Radio Modems • 42 
Running BearingTrack • 23 

S 
Saving the Map File • 40 
Scanning Channels • 29 
Scanning in an Image • 37 
Selecting the Serial Port • 15 
Setting the Sampling Delay • 28 
Setting Up BearingTrack • 10 

Index 



 

52 Index 
 

T 
Telephone Modems • 43 
The Display menu • 38 
The Enter Points menu • 38 
Tracking an RF Source • 25 
Tuning the Receiver • 32 

U 
Using a map program • 36 
Using BearingTrack • 9 
Using BearingTrack Server • 45 
Using Dial Up Modems • 31 
Using the BearingTrack Program Suite • 8 
Using the MapExpert program • 36 
Using this Manual • 3 
 


